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Introducing CorelDRAW® Technical Suite 201/

CorelDRAW® Technical Suite 2017 is the complete
solution for visual communication and technical
publication — print, online and to mobile devices.
Industry-leading file compatibility, precise illustration
tools, and productivity-enhancing features streamline
the workflow of today’s technical communication
professionals and technical graphics users, simplifying
single-source publishing of standards-compliant
technical publications for a global market.

Precision

Corel DESIGNER® 2017 is renowned for its specialized
tools and features designed for the specific tasks

required by technical illustrators. From intuitive
projected drawing and enhanced boundary effects to
new node customization and selection, Corel
DESIGNER 2017 offers everything you need to create
clear and accurate technical illustrations. A large
collection of powerful and dedicated illustration tools
simplifies the creation of high-quality technical

communication projects, including sophisticated
documentation, detailed assembly instructions, user
and maintenance manuals, and more.
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Compeatibility

The industry-leading file format compatibility of
CorelDRAW Technical Suite 2017 ensures that technical
graphics professionals can access critical data from
various sources and deliver technical files in a readable
format. You can export to over 100 file formats, so you
can exchange files with colleagues and clients
worldwide and produce a range of downstream
outputs, including 3D PDF.

You can also rely on compliance with various
standards-based systems thanks to enhanced support
for technical publication standards, including
WebCGM, S1000D, ATA iSpec 2200, SVG and PDF.
Collaborating with colleagues and clients has never
been easier. Whether it's AutoCAD® DWG® and DXF,
Adobe® lllustrator® CS/CC, Adobe® Photoshop®
CS/CC, Microsoft® Publisher, or Adobe® Acrobat®,
you can access and repurpose data from a wide range
of formats.

You can take advantage of Lattice3D Studio Corel
Edition to open, edit, and modify 3D models and
import 3D views into your technical illustrations. This
3D visualization application is fully integrated with
Corel DESIGNER, CorelDRAW® and Corel® PHOTO-
PAINT", so you can easily output 3D files to high-
quality vector illustrations and bitmap renderings. As
an optional add-on, Lattice3D Studio CAD Corel
Edition has enhanced native file format support for 3D
CAD systems and exchange file formats.

Productivity

With CorelDRAW Technical Suite 2017, you'll work
more efficiently and productively thanks to a wide
array of new and enhanced features — from
workspace customization options to support for Ultra
HD and multi-monitor workflows.

Corel DESIGNER 2017 also offers enhanced Translation
Memory System (TMS) support that allows for cost-
effective production of multi-lingual technical
communication.

What's more, CorelDRAW Technical Suite 2017
provides professional creative design and image
editing applications, such as CorelDRAW 2017 and
Corel PHOTO-PAINT 2017, which are ideal for
producing downstream outputs from a technical
illustration or imported 3D design, such as marketing
collateral, graphics, and presentation materials.
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Choose your purchase option

In the interest of user choice, there are several
CorelDRAW Technical Suite purchase options.

Perpetual License

At Corel, we strongly believe that you should not be
forced into a rental model if you don't want it. For a
onetime payment, a CoreIDRAW perpetual license
gives you the right to use the software forever, with no
extra monthly cost. By purchasing a box, download
version or volume license version of the product, you
get access to the full benefits of a specific version, and
there is no need for a permanent Internet connection.
With the optional Upgrade Program or Maintenance
Program (for volume licenses) customers can
additionally benefit from receiving major version
upgrades immediately when they become available.

Subscription

A CorelDRAW® Subscription is an affordable way to
stay up-to-date with the latest tools and
enhancements of CorelDRAW Technical Suite. It offers
a cost-effective alternative to paying the upfront cost
of the software. Instead, you'll get a full, downloadable
version of CorelDRAW Technical Suite* that remains
entirely functional for as long as your subscription is
active. You decide how and when you want to use it.
An annual plan offers an overall discount, with the
option to auto-renew or end your subscription after
the 12-month period. Your subscription entitles you to
the latest performance enhancements and updates. It
also entitles you to the next major version upgrade for
as long as your subscription is active.

Upgrade Program

The CoreDRAW® Upgrade Program is the hassle-free
way for technical illustrators and technical graphics
users to keep their toolbox up-to-date at the best
price. If you own a version of CoreIDRAW Technical
Suite with a perpetual license, you pay one affordable
fee once a year, and you're assured of working with
the latest design tools, new file compatibility, and the
most current technology. And as long as your account
is active, you'll automatically get the latest version of
CorelDRAW Technical Suite. Best of all, sign up once
and forget about it. In addition, if your needs change,
you will continue to own the last version you received
through the upgrade program.

Volume License options for teams and organizations

CorelDRAW Technical Suite can also be licensed for
teams and larger groups in an organization. Both
options — perpetual license, and software
subscription license — are commonly referred to as
the Corel Transactional License program (or CTL for
short) and are available to order from one of our many
authorized Channel resellers. Organizations who
purchase CorelDRAW Technical Suite licenses in
volume can secure a much lower overall cost to the
organization. If perpetual license owners want to stay
current with new releases however, they can opt in for
the Maintenance program. The Corel Maintenance
Program guarantees that customers automatically
receive all new releases during the lifetime of the
program, as well as benefiting from advanced support
and cumulative cost savings if additional seats are
required.

For more information about the Corel Licensing
program, please visit www.coreldraw.com/business.

* A corel.com account and Internet connection are required to
download and use the application and manage your
subscription.
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Customer profiles

Technical communication
professionals

These users often have formal training in a technical or
graphics field, such as technical illustration or
technical writing. They work in discrete manufacturing,
automotive, aerospace, high tech and
telecommunications, architecture, engineering and
construction (AEC), and apparel industries.

The graphics created by technical illustrators are used
in assembly instructions, user guides, illustrated parts
catalogs (IPCs), maintenance manuals, schematics, or
wiring diagrams. These documents are output to
various media, such as print, the web, mobile devices,
and interactive electronic technical manuals (IETMs).

Technical communication professionals in today’s
global markets need to create technical publications in
multiple languages for a worldwide customer base.
The ability to work seamlessly with Translation
Memory Systems (TMS) used in the localization
workflow is critical to streamline processes.

In addition, many organizations rely on content
authoring and management systems, so they seek
solutions that can be easily integrated.

Technical graphics users

These users are often self-taught in graphic-creation
tasks and include knowledge workers in medium to
large enterprise environments, such as manufacturing,
automotive, telecommunication, pharmaceuticals,
chemicals, and energy industries.

Among their many tasks and responsibilities is the
need to create a variety of graphics, including
diagrams used in presentation materials, floor plans,
schematics, and marketing materials.

These users may create graphics from scratch or base
them on legacy files. They often work collaboratively,
and the graphics they create may later be imported
for reuse with office-productivity, diagramming, and
desktop-publishing software.

In a typical organization, there may be many technical
graphics users spread across several departments.
They are not generally required to use the software
daily, and as such, they do not often get opportunities
for extensive training.

Organizations require cost-effective and easy-to-use
solutions that enable their users to repurpose legacy
files and 2D CAD data — and eventually 3D CAD data.
They also need tools for creating basic technical
diagrams and publishing standardized outputs.
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What's included?

Applications

Corel DESIGNER® 2017: This specialized
application streamlines the technical graphics
workflow by offering precision vector drawing,
page layout, and diagramming tools that meet
the demands of technical illustrators and technical
graphics users.

CorelDRAW® 2017: This intuitive vector-
illustration and page-layout application is the
perfect partner for Corel DESIGNER. It offers
graphics users additional creative graphics and
design tools that are ideal for more artful
endeavors, such as marketing collateral outputs.

Corel® PHOTO-PAINT™ 2017: This professional
image-editing application lets you quickly and
easily retouch and enhance photos for both
technical communication and creative graphics
projects.

Lattice3D Studio Corel Edition: This 3D
authoring application lets you create vector
illustrations and photo-realistic renderings from
3D views, including cross sections and 3D element
modifications, such as the creation of exploded
views.

Corel Font Manager™ 2017: This standalone font
management application lets you find, organize,
and preview local fonts, as well as online fonts on
the Content Exchange.

Corel® PowerTRACE® 2017: This convenient utility
lets you quickly and accurately convert bitmaps,
such as scanned blueprints, into editable vector
graphics.

Corel® CONNECT"™ 2017: This full-screen browser
connects you to the suite’s digital content library,
and lets you search your computer, local network,
and online sources to quickly find the perfect

complement for an illustration. Fully integrated, it
is also available as a docker in Corel DESIGNER,
CorelDRAW, and Corel PHOTO-PAINT.

Lattice3D Player: This 3D viewer is integrated
with Corel DESIGNER 2017 for the insertion of 3D
data assets in technical illustrations. It provides the
ability to modify 3D views and display modes.

Corel CAPTURE™ 2017: This one-click utility lets
you capture images from your computer screen,
which is especially useful for creating illustrated
software documentation, such as user guides.

PhotoZoom Pro 4: This plug-in lets registered
users export and enlarge digital images from
Corel PHOTO-PAINT.

Supporting applications

Microsoft® Visual Basic® for Applications 7.1: This
integrated development environment includes 64-
bit support and helps you streamline your
workflow by automating tasks.

Microsoft® Visual Studio® Tools for Applications: This
toolset includes the power of the .NET framework,
so developers can create time-saving plug-ins and
add-ons with Visual Studio to automate tasks and
extend functionality.

Duplexing wizard: This wizard helps you optimize
your work for two-sided printing.

Barcode wizard: This wizard lets you generate bar
codes in a wide range of industry-standard
formats.

Content

More than 4,000 industry-standard Architectural,
Electrical, General, Mechanical, and Tools symbols

More than 350 templates, including more than 40
technical ANSI, DIN, and ISO standard templates
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Content

*  More than 4,000 industry-standard Architectural,
Electrical, General, Mechanical, and Tools symbols

+  More than 350 templates, including more than 40
technical ANSI, DIN, and ISO standard templates

+ 10,000 high-quality clipart and images
« 2,000 high-resolution digital photos
«  Over 1,000 TrueType and OpenType® fonts

«  Over 500 interactive frames and photo frames

«  Over 600 fountain, vector and bitmap fills

Documentation
«  Online Help files
« User Guides (PDF and eBook formats)

* Video tutorials

CorelDRAW Technical Suite 2017
system requirements

+  Microsoft® Windows® 10, Windows® 8.1 or Windows®
7 SP1, in 32-bit or 64-bit, with the latest updates and
service pack installed

* Intel® Core®i3/5/7 or AMD Athlon" 64
+ 2 GBRAM

« 1GB hard disk space (for typical installation
without content)

*  Mouse, tablet, or multi-touch screen

» 1280 x 720 screen resolution at 100% (96 dpi)
« DVD drive (required for box installation)

»  Microsoft® Internet Explorer® 11 or higher

*  Microsoft .NET Framework 4.6

» Internet connection is required to sign in to
authenticate CorelDRAW Technical Suite, receive
performance and stability updates, access online
content, and use some features, such as QR Codes
or the Content Exchange. You can use CorelDRAW
Technical Suite offline. As a subscription user you
need to connect to the Internet at least once a
month.

Lattice3D Studio CAD Corel Edition
system requirements

For processing 3D CAD assembly data we
recommend:

*  Microsoft Windows 10, Windows 8.1 or Windows 7
(64-bit editions) with the latest updates and service
pack installed

*+ 8 GB RAM or more
« 1280 x 800 or higher screen resolution

» Internet connection required for product
activation and installing updates

Lattice3D Studio Corel Edition is included and installed
with CorelDRAW Technical Suite 2017. The Lattice3D
Studio CAD Add-On product unlocks additional
functionality for the integrated application.
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Key features

CorelDRAW Technical Suite 2017 is a complete and
cost-effective solution for authoring visual
communications for publishing to print, online, and
mobile devices.

Precision

Technical illustrators require specialized tools,
designing to the exact specifications of visually
detailed assembly instructions, complex user manuals
and multi-faceted documentation. Core|DRAW
Technical Suite 2017 provides projected drawing,
illustration, callout, dimension, boundary and image-
editing tools that help users work with precision and
deliver the accuracy required for any type of technical
communication project.

Enhanced! Projected drawing: In response to user
feedback, projected drawing in Corel DESIGNER is
more intuitive. Now you can create new objects and
edit existing ones using the dimensions and
coordinates of the active projected plane. The Ul
displays the projected-plane values that you'd expect,
so you can accurately draw, move, copy, stretch, and
scale objects, giving you increased precision and
productivity when authoring isometric drawings.

S 4

You can draw and edit using the scale of the projected axes
according to the settings of the active projected plane.

Give it a try

Working with isometric drawing

1 Press F10 to display the document grid.

2 Onthe Drawing Plane toolbar, click the Top [®)] button.

3 Click Window » Object Coordinates to open the
Object Coordinates docker.

4 Click View P Toolbars » Transform to open the
Transform toolbar.

5 In the Object Coordinates docker, type 20 in both
Object Size boxes, and click Create Object.

6 Type 10 in both Object Size boxes, and click Create
Object to create a concentric square.

Note the Transform toolbar and Object
Coordinates docker display the projected height
and projected width values.

7 Click Window » Transformations » Size to open
the Size page of the Transformations docker.

8 Type 1in the Copies box, type 5 in the Xand Y
boxes, and click Apply to create a new shape
instead of modifying the selected square.

9  On the Drawing Plane toolbar, click the Front @ button.

10 Click the 3-Point Rectangle tool in the toolbox.

11 In the drawing window, point to the left corner of the
largest rectangle, drag to bottom corner, and release
the mouse button.

12 Move the pointer down to draw the height, and
click.

Note the Transform toolbar displays the actual
height in the active projection.

13 You can precisely adjust the height. On the
Transform toolbar, click a top point on the origin

locator &2 and enter the precise height in the
Object Size box, and press Enter.

CorelDRAW

Technical Suite 2017

includes Corel DESIGNER™

Reviewer's Guide [ 9]



Enhanced! Boundary options: When 2D CAD files or
previously converted line drawings are used as the
source for technical illustrations, sometimes there are
gaps in lines that were supposed to form a closed
shape. This can lead to time-consuming manual
reworking of the illustration. To that end, Corel
DESIGNER 2017 offers more flexibility when using a
boundary around multiple shapes to create a single
closed curve object. You can now include open lines in
the object being created with the Boundary effect. A
new gap tolerance control lets you specify a distance
between the end points of open lines. End points
within that tolerance are temporarily repositioned to
close the gap between objects and allow a boundary
to be created.

You can extend curves to create boundaries in
shapes that have small gaps between curves.

Enhanced! Vector previews, nodes, and handles:
CorelDRAW Technical Suite 2017 simplifies shaping
curves and objects with redesigned nodes and
handles that are easier to see and manipulate.
Enhanced vector previews help you edit more
efficiently by ensuring nodes and curves stand out
against background colors in your design.

Enhanced previews, nodes, and handles
don't get lost in background colors.

New! Prominent interactive sliders: It's easier than
ever to work with object fills, transparencies, blends,
extrusions, drop shadows and more thanks to
enhanced interactive sliders that are more visible.

Prominent interactive sliders simplify working
with object fills, transparencies, and more.

New! Selecting adjacent nodes: Corel DESIGNER 2017
and CorelDRAW 2017 offer enhanced node selection
that simplifies working with complex shapes. You can
now select adjacent nodes on curves by using the
Shape tool while holding down Shift. You can also
change the direction in which the nodes are selected.

You can select several adjacent nodes (left), and you can
change the direction in which the nodes are selected (right).

New! Copying curve segments: Another new time-
saving enhancement in Corel DESIGNER 2017 and
CorelDRAW 2017 is the ability to copy or cut a specific part
of a curve segment. You can then paste it as an object,
making it easy to create new adjacent shapes with similar
contours.
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You can copy, paste, or duplicate pieces of existing curves,
allowing you to reuse curve segments in your projects.

New! Custom node shapes: Corel DESIGNER 2017
and CorelDRAW 2017 simplify shaping curves and
objects by assigning each node type a unique shape,
making it easy to identify smooth, cusp, and
symmetrical nodes. Technical graphics users can tailor
the look of nodes to best suit their workflow or project
with new options for customizing their shape, size,
and color. They can also accelerate modifying
elements in designs by choosing to show the direction
of curves and using a range of drawing tools to edit
nodes.

You can assign each node type a unique
shape, making them easy to identify.

New! Custom colors for previews and curve editing:
New color personalization options help you edit
objects more efficiently by letting you choose the
colors for nodes, handles and previews that will stand
out against underlying colors, making them easier to
see.

You can choose custom colors for
nodes, handles, and previews.

Give it a try

Using enhanced node editing
1 Click Tools » Options.

2 In the Workspace list of categories, click Nodes
and handles.

3 In the General settings area, do any of the
following:

« To change the node size, choose a size from the
Node size list box.

« To change the node shape, choose a shape for
cusp, smooth and symmetrical nodes from the
Node shape list boxes.

« To show or hide the direction of selected curves,
enable or disable the Show curve direction
when editing check box

4 In the Colors area, choose Custom from the Color
scheme list box., and do any of the following:

« Open the Main color picker, and choose the
color used in nodes and handles when an object
is selected for editing.

« Open the Secondary color picker, and choose
the color used in nodes and handles when
additional objects are selected for editing with
the Shape tool or when you are editing vector
effects such as extrusions

« Enable the Show node types in different colors
check box to display each node type in a
different color.

5 With a document open, click the LiveSketch K’
tool in the toolbox, and sketch in the drawing
window.

6 Click the Shape (‘ tool, hold down Shift, and
select adjacent nodes.

7 Press Ctrl + C to copy it or Ctrl + X to cut it, then
Ctrl + V to paste it.

New! Hiding and displaying objects: Corel DESIGNER
lets you hide objects and groups of objects so that
only the sections you want or need to see in a project
are displayed. When working with complex designs,
the ability to hide a particular element in your drawing
can be a great time-saver. It ensures that you don't
inadvertently select and edit an object that you hadn't
intended to work on, and it lets you experiment with
your designs more easily.
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You can hide individual objects or groups of objects on a
layer without hiding the entire layer.

Enhanced! Knife tool: With the enhanced Knife tool,
you can split vector objects, text and bitmaps along
straight, freehand or Bézier lines. You can create a gap
between the split objects or have them overlap. You
can also choose whether to convert outlines into curve
objects that can be manipulated or keep them as
outlines. And if you're unsure, Corel DESIGNER can
eliminate any guesswork by automatically choosing
the option that best preserves outline appearance.

Splitting objects with the enhanced Knife tool

Font list box: With the Font list box in CoreDRAW
Technical Suite 2017 applications, you can view, filter,
and find fonts easily. In addition to the font filters
available before, you can filter fonts based on weight,
width, supported scripts, and more. You can also use
keywords to search for fonts. In addition, any folders
or font collections added to Corel Font Manager are
accessible from the Font list box in Corel DESIGNER,
CorelDRAW and Corel PHOTO-PAINT, allowing you to
use fonts that are not installed in your drawings and
documents.

New! Drop shadows with Gaussian Blur feathering:
Drop shadows are a great way to enhance elements in

your designs. In Corel DESIGNER 2017, you can create
more realistic drop shadows that have natural-looking
feathered edges in an instant thanks to the Feathering
direction button on the property bar.

New! Correcting perspective distortions: With the
Straighten Image dialog box in Corel DESIGNER,
CorelDRAW and Corel PHOTO-PAINT, you can correct
perspective distortions in photos that have straight lines
and flat surfaces. Now in a few clicks, you can easily fix
photos of buildings, landmarks, or objects that appear
in the wrong perspective or that were taken from an
angle other than directly in front.

Symbol Manager docker: Technical illustrators often
use symbols for standard drawing components, which
can appear multiple times in an illustration. To that
end, the Symbol Manager docker simplifies creating,
editing, and managing symbols, including custom
defined symbol libraries. Corel DESIGNER 2017 also
offers over 4,000 technical symbols, helping you
quickly add precise detail to technical illustrations.

Alignment and Dynamic Guides docker:
When creating a design, alignment and dynamic

guides give technical illustrators speed and precision.
Alignment guides help you position objects more
quickly and lay out a drawing with precision by
appearing on the fly with suggested alignments to
existing objects on your page. Dynamic guides help to
align, draw, and move objects in precise relation to
other objects. You can use the Alignment and
Dynamic Guides docker to access and modify the
configuration of these guides more quickly.

Fully customizable, dynamic guides are temporary
guides that appear from the following snap points in
objects — center, node, quadrant, and text baseline.
With gravity snapping, technical illustrators snap the
cursor to various points in objects, making it easy to
create and position objects accurately. And so you can
work more efficiently, gravity shortcut keys let you
activate a single type of gravity snap.
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Compeatibility

Technical graphics professionals need to easily
exchange files with colleagues and clients worldwide.
To that end, CorelDRAW Technical Suite 2017 provides
industry leading file format compatibility, including
enhanced support for 3D CAD, CGM (including
WebCGM, S1000D, ATA iSpec 2200), SVG, DWG, PSD,
Al, PDF and RAW formats. The ability to export to over
100 file formats, including 3D PDF, ensures hassle-free
file sharing.

Enhanced! CGM support: Corel DESIGNER delivers
advanced support for CGM files, an industry-standard
format critical to a range of sectors, including
aerospace, defense and automotive. If your drawings
are used in interactive electronic technical manuals
(IETMs), you can make those files even more
information-rich by adding hotspots to callout shapes.
Then, when you output a drawing to a CGM V4 file,
the callout is responsive when clicked or hovered over.

A redesigned CGM Export dialog box gives technical
illustrators complete control when outputting a
drawing to a CGM file. More CGM V4 profiles are
supported, including S1000D (2.3, 3.0, 4.0, and 4.1) and
ATA GREXCHANGE (2.8-2.12). Metadata support is
improved, including enhanced Application Structure
(APS) attribute handling. You can also now include
Information Control Number (ICN) when using the
S1000D profile and Graphic Number (GNBR) when
using ATA GREXCHANGE. Corel DESIGNER also offers
better CGM file importing, with improved handling of
bitmap elements in CGM files.

The redesigned CGM export dialog box offers more settings
for advanced support for industry-standard CGM profiles.

Enhanced! File format compatibility: Corel
DESIGNER has enhanced support for the latest
versions of two formats widely used in technical
publications, WebCGM and SVG, ensuring that you
can easily exchange files with colleagues and clients
worldwide and produce a range of downstream
outputs. Corel DESIGNER also offers a range of PDF
options, including publishing your document as a 3D
PDF or to the ISO compliant PDF/A archiving format.
In addition, if a PDF that you're importing contains
objects that fall outside the drawing page, you can
now leave them intact or crop them to the drawing
page. You can import from and export to more than
100 file formats, including EPS, DWG, TIFF, PNG, JPEG.
What's more, files saved in the Al or PSD file format
can be easily imported to Corel's ecosystem where
work can continue without missing a beat.
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You can work and share with confidence using enhanced
support for technical publication standards.

Enhanced! 3D authoring: Lattice3D Studio Corel
Edition has been enhanced for CorelDRAW Technical
Suite 2017. This 3D-authoring application lets you
open, edit, and modify 3D models and import 3D
views into your technical illustrations You can now
create vector illustrations and photo-realistic
renderings from 3D views and send them to Corel
DESIGNER or CorelDRAW, where you can import 3D
models as 2D vector graphics to your drawings. You
can also import IGES files, a 3D CAD exchange format
that supports solid geometries. Lattice3D Studio Corel
Edition also offers enhanced search-and-select
functionality, a more streamlined Ul, and improved
display options for selections.
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New! Stylus tilt, bearing, and rotation: Increased
support for a number of real-time input factors let you
get more out of your stylus. In Corel DESIGNER, the
new Expression tool lets you use pressure, tilt, and
bearing to vary brushstrokes, and the improved Eraser
tool is now responsive to your pen or stylus. Plus,
stylus support has been enhanced in Corel PHOTO-
PAINT for the Eraser tool, the Paint tool, and other
brush tools.

Increased support real-time input factors lets you get more
out of your stylus.

Enhanced! Windows Real-Time Stylus Support:

You can use your RTS-compatible pen tablet or device
to work on the fly. Support for the Windows Real-Time
Stylus delivers truly responsive pressure sensitivity and
tilt and gives you full control of your brushstrokes in
CorelDRAW Technical Suite 2017. What's more, there's
no stylus driver to install, so you can get to work right
away.

You can use your RTS-compatible
device to control your brushstrokes.

New! Microsoft Surface Dial support: If a Microsoft
Surface Dial is part of your workflow, Corel DESIGNER

offers native support on Windows 10 to give you a
greater range of ways to create and interact with
technology.

The Surface Dial can help you zoom in and out as well as
undo actions while you're working.

Insert 3D Model: Unique to Corel DESIGNER 2017,
when you import 3D models, you can place them and
resize them interactively similarly to other imported
objects, and combine them with 2D vector
illustrations, text, and images in the same document.
You can embed a 3D model (XVL file), which gives you
the option of editing the 3D model within the Corel
DESIGNER (DES) file at any time. What's more, if you
share the file with other users, they'll be able to work
directly with the embedded 3D model, eliminating the
need to distribute both the DES and external XVL files.
You can link a 3D model, which automatically updates
it in a DES file whenever the XVL file is modified in
Lattice3D Studio Corel Edition.

Step-by-step assembly

You can embed or link 3D models in drawings.

3D PDF support: You can publish technical drawings
to 3D PDF from Corel DESIGNER 2017, giving you the
power to create documents that combine text, vector
graphics, images, and embedded 3D models. Using a
PDF reader that supports 3D PDF viewing, the end
user can interact with the 3D model. They can
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intuitively rotate, move and size it, access assembly
and part structure information, and take a look inside
a 3D model by displaying cross-sections.

3D PDF is an excellent cross-media format. In addition
to being ideal for electronic distribution, it can also be
used for print, with the 3D content being printed in its
default view.

Step-by-step assembly

You can create 3D PDFs.

Give it a try

Inserting a 3D model and publishing it to 3D
PDF

1 With a drawing open, click File » Insert 3D Model.

If this menu command is not available, you must
update your installation to include Lattice3D
Player.
2 Locate and open the XVL (*xv2) file that you want
to insert.
To embed the 3D model, disable the Import as
linked file check box.
3 Drag in the drawing window to insert the file at the
desired size and position.
You can modify the view of the 3D model, or

access stored views and cross-sections that were
created in Lattice3D Studio Corel Edition.

4 Click File » Publish to PDF.

5 In the Publish to PDF dialog box, click Settings,
and choose Acrobat 8.0 or higher from the
Compatibility list box to ensure that the 3D model
is interactive in PDF readers.

6 In the Publish to PDF dialog box, click Save.

7 Ina PDF reader that supports 3D PDF viewing, such
as Adobe Reader, open the file you created in step
6.

The 3D model can be rotated, panned, and more.

New! Send to CoreDRAW: In addition to
transforming 3D views to vector graphics for
technical-illustration authoring in Corel DESIGNER,
you can now also send an active 3D view in Lattice3D
Studio Corel Edition to CorelDRAW. The vector
graphics output from Lattice3D Studio can then be
used as source files for the creation of marketing
collateral and other creative deliverables based on
engineering data.

Productivity

Technical communication professionals are always
seeking new ways to streamline their workflow and
work faster. CoreIDRAW Technical Suite 2017 offers a
wide array of time-saving new and enhanced features.
You can customize your workspace to suit the way you
work, take advantage of Ultra HD and multi-monitor
support, create illustrations with localized text for a
global market, and more.

Enhanced! TMS support: The creation of technical
documentation for a global market and the reduction
of localization costs offered by a Translation Memory
System (TMS) has been enhanced. Now when
exporting text in a drawing to the XML Localization
Interchange file format (XLIFF) — the industry-
standard format for sharing translatable text between
a TMS and software — recognition of the source
language has been improved in Corel DESIGNER 2017.
In addition, the translated text you receive back now
always respects the original formatting. This lets you
create a language-specific file with identical content
and formatting, except the translated text strings.
Alternatively, a new option for importing translated
text into copied text objects on a separate layer allows
for the creation of multi-lingual documents with
language-specific layers, which can be turned on and
off as needed.
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Corel DESIGNER simplifies the creation of technical
documentation for a global market.
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Give it a try

Working with translated text
1 Open the sample file TMS-workflow-sample.des.

This file can be found in the sample files, available
for download: www.coreldraw.com/
cdts2017samples.

The sample file contains text.
2 Click File » Import for Translation.

Locate the folder where you want to save the file
that will contain the translated text, and click Save.

3 In the Open dialog box, choose the file
TMS-workflow-sample-EN-DE.xIf, and click Open.
This XLIFF file contains German translations of all

text objects in the file TMS-workflow-
sample.des.

4 Click Open.
The English text is replaced with German text.

5 Inthe Object Manager, show the FR layer using the
Show or Hide button and unlock it using the Lock
or Unlock button.

The FR layer contains copies of the original English
text objects.

6 In the Object Manager, make the EN layer
containing the translated German text visible using
the Show or Hide button and lock it using the Lock
or Unlock button.

7 Click File » Import for Translation.

8 Choose the file TMS-workflow-sample-EN-FR.xIf,
and click Open.

This XLIFF file contains French translations of all
text objects in the file TMS-workflow-
sample.des.

9 Inthe Object Manager, hide the FR layer visible and
show the EN layer using the Show or Hide buttons

to switch between languages displayed in the
multi-lingual document.

New! Support for UltraHD 5K displays: An updated
interface and support for 5K monitors means that
technical communication professionals can
comfortably view Corel DESIGNER, CorelDRAW, and
Corel PHOTO-PAINT on even the most high-definition
monitors, including UltraHD. This allows designs and
photos to be edited at their native resolution while
maintaining the subtlest details in the image. And with

more pixels to work with, several windows can be
opened side-by-side for an efficient workflow.
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You can scale the Ul up to 250%.

Enhanced! Windows 10 support: Thanks to our
relentless pursuit of delivering the highest quality user
experience, CorelDRAW Technical Suite 2017 is fully
compatible with and certified for Windows 10. Corel
delivers enhanced reliability and performance, so
users can maximize their productivity when working
on the world's most popular operating system.

New! Advanced multi-monitor support: Per-Monitor
Ul scaling and improvements to multi-monitor
support allow technical graphics professionals to take
advantage of the sharpness and fidelity of new High-
DPI monitors and laptops while still using lower-DPI
monitors to maximize design space (requires
supported hardware and Windows 8.1 or later). This
ensures that Ul elements scale properly and appear
crisp and legible on screens of all resolutions. For
example, you can drag a document out of the
application window and place it within a second
screen, dedicating one monitor to a drawing or image
and the other to frequently used dockers and toolbars.

New! Product Details tab: You can learn about the
product and your account in the updated Welcome
Screen in CorelDRAW Technical Suite 2017. The new
Product Details tab provides important information
about the product, user account details, and
authentication status. Users can also find useful
information about product updates. Links to upgrade
to the next release or a trial version to a full license,
and even renew a subscription can all be found here.
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New! LiveSketch™ tool: This revolutionary tool uses
an Artificial Intelligence technology called a neural
network that gives users an entirely new way to bring
their vector designs to life. LiveSketch is perfect for
kick-starting a project and getting the idea in your
imagination onto the screen in front of you. Great
when working with a stylus or on a touch-enabled
device, it combines the speed of sketching with
flexible stroke-adjustment controls so you can begin
your design concepts using hand-drawn vector curves
right from the get-go.

Capture design concepts using hand-drawn vector curves.

The LiveSketch tool lets you capture design concepts
using hand-drawn vector curves. If you've ever used a
scanned sketch as the basis for a project, you'll quickly
see the time-saving possibilities that the LiveSketch
tool offers. Not only does it eliminate the need to scan
and trace a drawing, but it also gives you total control
over how your strokes are adjusted and converted to
curves. Intuitive settings let you easily fine-tune how

CorelDRAW 2017 meshes with your sketching cadence.

Strokes before (top) and after (bottom)
stroke adjustment: discrete overlapping strokes (left),
folded strokes (middle), chicken scratch (right)

Strokes created with the LiveSketch tool are adjusted
and added to existing curves based on the time and
distance between them. You can set the time it takes

to activate stroke adjustment after you've stopped
drawing and the distance at which strokes are
automatically added to existing curves.

/

With the timer set to 0 milliseconds (left), successive strokes
are converted into discrete curves. With the timer set to 1
second (right), successive strokes are joined into a single curve.

You also have the option of combining all strokes
drawn within the specified time frame into a single
curve, regardless of the distance between them.

oy
/
%

An example of an object created from
strokes joined into a single curve.

>

If you want to extend an existing curve, simply hover
over it until it turns red and continue to sketch. The
subsequent stroke is seamlessly added to the existing
curve, allowing you to sketch, adjust and edit on the
fly. When you include an existing curve into a sketch,
the resulting curve inherits the properties of the
existing curve.

Regardless of your sketching experience, you'll be
amazed how quickly you can produce impressive
results.
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New! Touch-friendly Ul: Tablet Mode support makes
it easy to sketch on the fly and make quick
adjustments using touch or a stylus. The new Touch
workspace streamlines the Ul to maximize the size of
the drawing window by displaying only the tools and
commands that you're most likely to use in the field
on a tablet. All other features are still accessible in a
couple of taps. And if you prefer working with one of
the desktop workspaces when you're in Tablet mode,
you can choose whatever Ul configuration works best
for you. You can now also save time and work faster by
panning and zooming in a single gesture.

The Touch workspace offers a touch-friendly environment
with access to all the essentials.

Corel Font Manager: When the number of fonts on
your system become less of a benefit and more of a
hassle, Corel Font Manager is the answer. It lets you
easily handle, organize, and explore your typeface and
font collections by giving you the tools to control
every aspect of your typography workflow. Whether
you want to find fonts for your projects, organize fonts
for easy access, or manage unneeded fonts, Corel
Font Manager has the tools you need. It lets you
access online fonts from the Content Exchange, which
can be installed or downloaded to use later. You can
browse and search online and local fonts, preview font
glyph sets, add custom font collections, and more.

When you add folders and create collections, all your
fonts, including ones that aren't installed, become
accessible from the Font list box in Corel DESIGNER,
CorelDRAW, and Corel PHOTO-PAINT. This means that
you can use fonts that are not installed in your

drawings and documents. In addition, any collections
that you create appear as font filters in the Font list
box of the main applications, so fonts can be filtered
to show only the ones included in specific collections.
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The Corel Font Manager simplifies exploring, organizing,
and managing your typeface and font collections.

New! Import legacy workspaces: CorelDRAW
Technical Suite 2017 lets you reuse Corel DESIGNER
workspaces that were created in versions X6 and X7.
You can also import CorelDRAW and Corel PHOTO-
PAINT workspaces that were created in versions X6,
X7, and X8. You have the flexibility of importing some
workspace elements and excluding others. You also
have the option of adding them to your current
workspace or creating a totally new Ul configuration.
And choosing which workspace elements to import or
export is faster than ever.

New! Fully customizable Ul: CoreIDRAW Technical
Suite 2017 offers more Ul customization options than
ever before, allowing you to tailor your design space
to create a unique work environment. Newly
redesigned icons permit scaling up to 250%, and you
can lighten or darken the application background by
choosing a theme.

CorelDRAW Technical Suite 2017 offers flexible
desktop color scheme options. You can change the
color of the area surrounding the drawing page in
Corel DESIGNER to set up the optimal environment for
each project, reduce the overall workspace contrast, or
increase the legibility of design elements.
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You can set the Ul color to optimize your work environment.

You can customize the color of window borders in
CorelDRAW Technical Suite 2017 to match your
personal preference. If you use more than one of the
suite's applications simultaneously, you can set
different border colors for each, which lets you quickly
identify them when switching programs.
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You can set border colors to switch between programs faster.

Give it a try

Customizing the Ul
1 Click Tools P Options.
2 Inthe Workspace list of categories, click Appearance.

3 In the Size area, move the slider to the right for
larger Ul items, and to the left for smaller Ul items.

The scaling level is relative to the scaling level of
the operating system. The default setting is 100%,
which means that Ul items in the application
appear the same size as similar Ul items in the
operating system. Scaling by 200% makes the
application Ul items appear twice as large as the
Ul items of the operating system.

4 Inthe Color area, choose from the Theme list box.

To make the workspace lighter or darker, you can
choose one of the following themes: Light,
Medium, Dark, or Black.

5 To change the border color of the application
window and dialog boxes, open the Window
border color picker, and choose a color.

6 To change the color of the area surrounding the
drawing page, open the Desktop color picker, and
choose a color.

Instant customization: The toolbox, dockers, and
property bars contain handy Quick customize buttons
which will help you tailor the interface to suit your
workflow. These buttons offer a fast and convenient
way to add dockers to your workspace, add or remove
tools from the toolbox, and add or remove items from
a property bar.

Property Bar x

& == & M o17Emm M —v||——m [+ 0,176 mm

I Ppattern Width
[J &4 Geometric Properties
[1%F Keep Settings

Reset toolbar

Customnize.

The Quick Customize buttons make workspace
customization fast and easy.

Open documents in floating windows: So you can
set up your workspace in the way that best suits your
style, Corel DESIGNER offers options for how your
documents open. You can have a number of
documents visible simultaneously in floating windows.
Or if you want to focus on one at a time, you can open
files in a the default tabbed view.

Get More docker: You can expand your collection of
tools by downloading for free or purchasing
applications, plug-ins, and extensions directly from
within CorelDRAW Technical Suite 2017. You can
download your free license of PhotoZoom Pro,
purchase AfterShot Pro for the ultimate RAW
workflow, experience Corel ParticleShop for amazing
bitmap effects, and more. In order to access this
collection of tools, you need to be connected to the
Internet.
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Accessing eBooks: The Corel DESIGNER 2017 User
Guide, CorelDRAW 2017 User Guide, and Corel
PHOTO-PAINT 2017 User Guide are now available as
eBooks. Published to the EPUB and MOBI file format,
the eBooks brings most comprehensive and up-to-
date information about product features to your
eBook reader. Following the user guides on an eBook
reader saves you switching between program windows
on your system, allows you to keep learning on the go,
and ensures access to the suite's Help files when you
don't have Internet access.

New! Community website for developers: With
support from the new Developer Community site, you can
create your own automation tools. There's a variety of
useful resources, including in-depth programming articles
and code samples, which can help you automate tasks
with macros and create custom features. And when you
have questions, you can turn to a community forum,
knowledge base, or the FAQ page. For more information,
visit www.community.coreldraw.com/sdk.

Object Styles: This productivity-enhancing feature
ensures a consistent visual style in technical
publications, making it easy to comply with military
and civil aerospace standards, such as S1000D and ATA
iSpec 2200. Object styles lets you edit a style or a style
set once and have the changes applied instantly
throughout a project. What's more, a pop-up appears
when you hover over a style in the Object Styles
docker, offering a quick preview of the style before it's
applied.

Color Styles docker: The Color Styles docker lets you
use styles and color harmonies to manage colors and
quickly implement project-wide color changes, which
is especially useful for producing iterative designs and
varying graphic outputs. The Color Styles docker also
offers convenient View Options, including Hint View,
which provides a visual indication of all document
objects that use a specific color style, and Page Sorter,
which displays thumbnails of all pages in a multi-page
document and previews changes as you adjust colors.
You can also click View » Page Sorter to access
thumbnails of all pages in a document, with live

previews of changes you make to the document’s
color styles.

QR Codes: With Corel DESIGNER 2017, you can add
scalable QR codes to a drawing, allowing you to give
technicians in the field the ability to access online
technical documentation from printed documentation
or machine labels using a smartphone. It's easy to
customize a QR code and analyze it to ensure it can
be read by QR code readers, mobile devices, and
scanners.

Multiple document interface: You can work with
multiple documents in a tabbed view, which helps you
stay organized and quickly switch between several
active documents.
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You can easily work on multiple documents simultaneously.

Content Exchange: The Content Exchange is an
online repository that integrates with Corel CONNECT
and the suite’s applications, making it quick and
effortless to access and share vector fills, bitmap fills,
and fountain fills with a community of other users. You
can instantly set any asset that catches your eye in the
Content Exchange as a favorite, which is a quick and
convenient way to keep a list of content that you
might want to download later.

Transparency: You can apply transparency to
individual color nodes within a fountain fill, allowing
you to adjust an object's transparency so that all
objects beneath it are partially visible.

Transparency settings are accessible in the Property
Manager docker in Corel DESIGNER 2017 (and the
Object Properties docker in CorelDRAW 2017), making
it fast and easy to apply and adjust object
transparency.
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It is fast and easy to apply and adjust object transparency.

Enhanced! Corel PHOTO-PAINT 2017: This
professional image-editing application offers technical
illustrators and technical graphics users a broad range
of professional and advanced photo-editing tools,
which are ideal for producing high-quality photo-
based technical documentation. Corel PHOTO-PAINT
2017 includes a variety of new tools and creative
options for retouching photos, correcting distortions,
blurring images, and enhancing your workflow.

The Healing Clone tool discreetly removes unwanted
spots and imperfections from an image by painting
with sampled texture and matching it to the color of
the area that you're retouching. In a few clicks, you can
seamlessly repair and blend a blemish or scar into the
rest of the photo.

With the enhanced Straighten Image dialog box, you
can correct perspective distortions in photos that have
straight lines and flat surfaces. Now in a few clicks, you
can easily fix photos of buildings, landmarks, or objects
that appear in the wrong perspective or that were taken
from an angle other than directly in front.

The Gaussian Blur special effect is now available as a
lens, so you can blur images without overwriting the
original image. When you create a lens, the changes you
make are non-destructive, so any edits are displayed on
the screen through the lens rather than applied to the
image pixels. The lens is created as a separate object on
a layer above the image background so you can edit the
lens and the background image separately, maintaining
the original’s data and quality.

And so you can set up your workspace in the way that
best suits your style, Corel PHOTO-PAINT offers
options for how your photos open. You can now have

a number of documents visible simultaneously in
floating windows. Or if you want to focus on one
image at a time, you can open files in a the default

tabbed view.
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Advanced 3D CAD repurposing: Lattice3D
Studio CAD Corel® Edition (optional add-on)

For organizations that require additional 3D editing
capabilities and direct access to 3D CAD assembly
files, CorelDRAW Technical Suite 2017 offers an
upgrade to Lattice3D Studio CAD Corel Edition. This
add-on provides native assembly and part file support
for 3D CAD systems used in discrete manufacturing,
such as the automotive, aerospace, and machinery
industries. Lattice3D Studio CAD Corel Edition lets
users do more with CAD files without the steep
learning curve of 3D CAD software.

Lattice3D Studio CAD streamlines the workflow of
technical communication professionals by reducing
the need to consult design engineers when preparing
graphics content. It supports a broad range of native
3D CAD file formats, such as assembly and part files
from CATIA, SolidWorks, PTC Creo Parametric
(formerly Pro/ENGINEER), Autodesk Inventor, NX,
SolidEdge, and more. It also supports 3D CAD
exchange formats, such as JT, IGES, STEP, and
Parasolid.

Enhanced! 3D CAD file options: You can send
multiple 3D views to Corel DESIGNER as vector
illustrations in one go. What's more, you can resend
newer versions of views stored as snapshots to update
existing illustrations in a DES file. In addition,
illustrations sent to Corel DESIGNER no longer include
a background rectangle, so objects behind the
imported illustration aren’t hidden by a rectangular
frame. 3D CAD file format support has been updated,
including improved STEP file importing. You can take
advantage of enhanced annotation features, display

options, and more. You also have the flexibility of
adding specific options from the standalone version of
Lattice3D Studio, such as the Process PDF Template
option, to a Lattice3D Studio CAD Corel Edition license.

Enhanced! Lattice3D Studio Corel Edition: A series
of enhancements are designed to help you work faster
and with more precision. You can now customize the
color of markers for increased visibility. Search results
are highlighted in the Assembly tree and Manufacture
tree panels and sorted by part number, simplifying
finding drawing components. A new option lets you
specify the range of neighboring parts to be
displayed, helping accelerate the design-review
process. And when making rectangular selections, you
can now choose to include all touched components or
only ones that are wholly enclosed.

Enhanced! Lattice3D Studio CAD Corel Edition:
This optional add-on delivers a variety of productivity
enhancements. When sending a snapshot to Corel
DESIGNER, you can specify which parts will be
outlined, significantly reducing file size. You can also
align notes to a specified link. The new Selection
Process view displays only parts that you specify, so
you can easily compare the selected parts to the entire
model view. To simplify managing assemblies, you can
highlight ones that aren't registered in the
Manufacture and Process trees, reducing the chance
of having missing parts. And when you're publishing
to Microsoft Excel, you can customize the size of
images in the report.
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Update / replace assembly functionality: Disassembly views, animations, and other 3D

Once a design moves to the production phase, authoring functions are maintained, so that you can
construction changes are common. With Lattice3D efficiently update technical illustrations with the most
Studio CAD, you can update early designs at any time current revision of the manufacturing design.

due to changes determined by construction.

The update or replace assembly functionality offered by Lattice3D Studio CAD Corel Edition
helps you ensure that the most current manufacturing revisions
are reflected at any time in the visualization workflow.

Update a 3D-sourced illustration: To speed up
technical-publication authoring, CorelDRAW Technical
Suite 2017 with Lattice3D Studio CAD Corel Edition
offers the Auto Detection and Update command. It
updates 3D visualizations created in Lattice3D Studio
CAD, stored snapshots, cross-sections and animated
procedures — including process animations for
illustrating complex, multi-step assembly, disassembly,
or maintenance procedures — based on the
modifications applied to the CAD source data. It also
lets you automatically generate updated vector
illustrations to replace ones in DES files that were
created using the Send to Corel DESIGNER

command. The illustration specifications, such as view, You can automatically update
3D-sourced illustrations.

positions of the objects, line weights and export
settings, are fully recognized and maintained. As a
result, the illustrations are recreated using the updated
3D model and inserted in the same place as the
original, allowing technical illustrators to start a
publication with a preliminary 3D design and update it
with the final design instantly.
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Give it a try

Updating a 3D-sourced illustration

To try this feature, Lattice3D Studio CAD Corel Edition
is required. The trial version of CorelDRAW Technical
Suite 2017 includes Lattice3D Studio CAD Corel Edition
(30-day trial).

1 In Lattice3D Studio CAD, open the sample file 3D-
assembly-v1.xv2.

This file can be found in the sample files, available
for download: www.coreldraw.com/
cdts2017samples.

2 Click File » Send to Corel DESIGNER.

3 Inthe Send to Corel DESIGNER dialog box, make
sure the Add snapshot check box is enabled, and
click Send.

In Corel DESIGNER 2017, the 3D illustration is
inserted in the active page. If the application is not
running, it will launch automatically.

4 C(Click File b Save.
5 In Lattice3D Studio CAD, save 3D-assembly-v1.xv2.
6 Open the sample file 3D-assembly-v2.xv2.

This file contains a modified version of the 3D
model.

7 Click File » Auto Detection and Update.

8 In the Auto Detection and Update dialog box,
choose the file 3D-assembly-v1.xv2 in the Edited
XVL box.

9 Click OK to all warning messages that appear.

10 In Lattice3D Studio CAD, click the Apply and
Execute button.

11 In the Auto Detection and Update dialog box,
enable the Update Illustration in Corel DESIGNER
check box, and click OK.

The 3D illustration is updated in the DES file.

Evaluation tools: Before 3D models and data can be
used in downstream applications, the integrity of the
3D model requires validation. Lattice3D Studio CAD
provides assembly evaluation tools for geometry and
measurements, interference check, and collision
detection so you can quickly verify the integrity of a
3D assembly.
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Additional 3D CAD tools: With Lattice3D Studio
CAD, you can edit 3D models and combine 3D models
from different CAD sources. It provides a rich 3D CAD
toolset that lets you modify and transform 3D parts,
shapes, and assemblies.

Animation tool set: Lattice3D Studio CAD provides a
full set of animation tools, including a dedicated
editing console as well as a method for automated
creation of disassembly animations. Process
animations can be created to capture complex, multi-
step assembly or maintenance procedures with
detailed instructions. The hierarchical structure of the
Assembly Tree view and the ability to create custom
tree structures for disassembly and process
animations gives you full control over the creation of
assembly, sub-assembly, and part structures for use in
illustrated assembly and maintenance instructions.
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Online and mobile outputs: Lattice3D Studio CAD
supports output of 3D models to HTML5 and for
mobile devices. By using the highly compressed XVL®
file format, you can share complex models with
virtually anyone, using the free Lattice3D Player as
browser plug-in for desktop/laptop or iXVL apps for
iOS. XVL is the most lightweight 3D format in the
industry, enabling data to be compressed to an
average 0.5% of its original size with high accuracy.
For example, a 500 MB 3D CAD assembly file can be
shared on mobile devices as an XVL file with an
approximate file size of 2.5 MB.

3D outputs: With Lattice3D Studio CAD Corel
Edition, you can output to various 3D file formats,
including 3DS, DXF, IGES, OBJ, STL, U3D, and VRML.
You can also publish directly to 3D PDF from Lattice3D
Studio CAD Corel Edition, using a PDF template with
animation controls.
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About Corel

Corel is one of the world's top software companies providing some of the industry’s best-known graphics,
productivity and digital media products. Boasting the most comprehensive portfolio of innovative software, we've
built a reputation for delivering solutions that are easy to learn and use, helping people achieve new levels of
creativity and productivity. The industry has responded with hundreds of awards for innovation, design, and value.

Used by millions of people around the world, our product lines include CorelDRAW® Graphics Suite,
CorelDRAW® Technical Suite, CorelCAD", Corel® Painter®, Corel® PaintShop® Pro, Corel® VideoStudio®, and Corel®
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Copyright © 2017 Corel Corporation. All rights reserved.
CorelDRAW® Technical Suite 2017 Reviewer's Guide

Protected by U.S. Patents 5652880; 5347620; 5767860; 6195100; 6385336; 6552725; 6657739; 6731309; 6825859;
6633305; Patents Pending.

Product specifications, pricing, packaging, technical support and information (“specifications”) refer to the retail
English version only. The specifications for all other versions (including other language versions) may vary.

INFORMATION IS PROVIDED BY COREL ON AN "AS IS” BASIS, WITHOUT ANY OTHER WARRANTIES OR
CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABLE
QUALITY, SATISFACTORY QUALITY, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR THOSE
ARISING BY LAW, STATUTE, USAGE OF TRADE, COURSE OF DEALING OR OTHERWISE. THE ENTIRE RISK AS TO
THE RESULTS OF THE INFORMATION PROVIDED OR ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO
LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, OR
CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT,
LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF COREL HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT LIABLE FOR ANY
CLAIMS MADE BY ANY THIRD PARTY. COREL'S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED
THE COSTS PAID BY YOU TO PURCHASE THE MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW
EXCLUSIONS OR LIMITATIONS OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE
LIMITATIONS MAY NOT APPLY TO YOU.

Corel, the Corel logo, the Corel balloon logo, CorelDRAW, the CorelDRAW balloon logo, Corel DESIGNER,
CAPTURE, CONNECT, LiveSketch, PHOTO-PAINT, PowerTRACE, CorelCAD, PaintShop Pro, Painter, VideoStudio,
and WordPerfect are trademarks or registered trademarks of Corel Corporation and/or its subsidiaries in Canada,
the U.S., and/or other countries.

Other product, font, and company names and logos may be trademarks or registered trademarks of their
respective companies.
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